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5
Controllo dell’interfaccia utente

Esercizio 5-1 Visualizzazione di temperatura e limiti

Obiettivo
Utilizzare i Property Node per cambiare programmaticamente le proprietà 
degli oggetti del pannello frontale.

Scenario
Completate un VI che registri la temperatura su un waveform chart. Durante 
l’esecuzione, il VI effettua i seguenti task:

• Imposta il valore Δx del diagramma sul valore definito dall’utente.

• Cancella il waveform chart in modo che inizialmente non contenga dati.

• Cambia il colore di un grafico se il dato supera un certo valore.

• Fa lampeggiare un indicatore d’allarme se il dato supera un certo valore.

Progetto
Aggiungete i seguenti Property Node a un VI esistente:

Tipo Nome Proprietà

Waveform Chart Temperature XScale.Multiplier

Waveform Chart Temperature History

Waveform Chart Temperature Active Plot 0»Plot.Color

Boolean Indicator (LED) Over Limit Blinking
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Implementazione
1. Aprite Temperature Limit.vi situato nella directory 

<Exercises>\LabVIEW Core 2\Temperature Limit. Il pannello 
frontale è già stato creato per voi.

Figura 5-1.  Pannello frontale di Temperature Limit

2. Aprite il diagramma a blocchi del VI. Una parte è già stata creata per voi. 
La Figura 5-2 mostra un esempio del diagramma a blocchi finale.

Figura 5-2.  Diagramma a Blocchi di Temperature LimitEs
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3. Modificate il VI in modo che imposti il valore Δx del chart sul valore 
d’ingresso Δt inserito dall’utente. 

❑ Cliccate con il tasto destro sull’indicatore Temperature e selezionate 
Create»Property Node»X Scale»Offset and Multiplier»
Multiplier dal menu rapido per creare un Property Node. 

❑ Inserite il nuovo Property Node alla sinistra del While Loop.

❑ Cliccate con il tasto destro sul Property Node Temperature e 
selezionate Change All To Write dal menu rapido.

❑ Dividete delta t (ms) per 1000 per determinare X-Scale Multiplier, 
come mostrato in Figura 5-2.

4. Modificate il VI per cancellare i vecchi dati dal chart Temperature prima 
di avviare l’acquisizione della temperatura. 

Suggerimento Per cancellare un waveform chart dal diagramma a blocchi, inviate un 
array vuoto di dati alla proprietà History Data.

❑ Ridimensionate il Property Node a due terminali.

❑ Selezionate la proprietà History Data nel secondo terminale.

❑ Verificate che la proprietà History Data sia impostata su Write.

❑ Cliccate con il tasto destro sulla proprietà History Data e 
selezionate Create»Constant dal menu rapido. 

❑ Collegate il Property Node come mostrato in Figura 5-2. 

5. Modificate il VI in modo che quando il VI acquisisce dati, renda rossa 
la traccia Data e il LED Over Limit lampeggi quando la temperatura 
supera il valore limite.

❑ Cliccate con il tasto destro sull’indicatore Temperature e 
selezionate Create»Property Node»Active Plot dal menu rapido 
per creare un altro Property Node.

❑ Inserite il nuovo Property Node nel caso True della struttura Case.

❑ Ridimensionate il Property Node a due terminali.

❑ Cliccate sul secondo terminale e selezionate Plot»Plot Color.

❑ Cliccate con il tasto destro sul Property Node e selezionate Change 
All To Write dal menu rapido.
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❑ Collegate una numeric constant con un valore 0 alla proprietà 
Active Plot per selezionare la prima traccia sul chart Temperature. 

❑ Collegate la costante color box Red alla proprietà Plot Color per 
impostare il colore della traccia su rosso quando i dati superano High 
Limit. 

❑ Create una copia del Property Node premendo <Ctrl> mentre 
selezionate e trascinate il Property Node.

Suggerimento Non utilizzate la clipboard (Edit»Copy o <Ctrl-C>) per creare una copia 
del Property Node. Questo crea un tipo diverso di Property Node che avete studiato nella 
sezione Control References della Lezione 5, Controlling the User Interface, nel Manuale 
del corso LabVIEW Core 2.

❑ Inserite la copia del Property Node nel caso False della struttura 
Case, come mostrato in Figura 5-3.

❑ Collegate una numeric constant con un valore 0 alla proprietà 
Active Plot per selezionare la prima traccia sul chart Temperature. 

❑ Collegate la costante color box Green alla proprietà Plot Color per 
impostare il colore della traccia su verde quando il dato è inferiore a 
High Limit.

Figura 5-3.  Caso False nel VI Temperature Limit

6. Modificate il VI in modo che quando il VI acquisisce dati, il LED Over 
Limit lampeggi quando la temperatura supera il valore limite.

❑ Cliccate con il tasto destro sull’indicatore Over Limit e selezionate 
Create»Property Node»Blinking dal menu rapido.

❑ Inserite il nuovo Property Node dentro il While Loop.

❑ Cliccate con il tasto destro sul Property Node e selezionate Change 
All To Write dal menu rapido.

❑ Collegate il Property Node come mostrato in Figura 5-2. 

7. Salvate il VI.Es
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Test
1. Avviate il VI per accertarvi che si comporti correttamente.

2. Chiudete il VI.

Fine dell’esercizio 5-1
Es
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Esercizio 5-2 Personalizzazione della finestra del VI

Obiettivo
Agire sugli attributi di un VI utilizzando Property Node e Invoke Node.

Scenario
Potete impostare le proprietà relative all’aspetto di un VI staticamente 
utilizzando la pagina properties del VI. Tuttavia, interfacce utenti efficienti 
spesso devono modificare l’aspetto di un pannello frontale mentre il 
programma è in esecuzione.

Dovete creare un VI che possa effettuare i seguenti task su richiesta:

• Mostrare o nascondere la sua barra title

• Mostrare o nascondere la sua barra menu

• Diventare trasparente così che gli oggetti dietro il VI possano essere visti

• Spostarsi al centro dello schermo

Progetto

Ingressi e uscite

Suggerimento Utilizzate i controlli Push Button poiché la loro azione meccanica di 
default è Switch When Pressed. Utilizzate il pulsante OK poiché la sua azione meccanica 
di default è Latch When Released.

Tipo Nome Valore di default

Push Button Show Menu Bar? Vero 

Push Button Show Title Bar? Vero 

Push Button Make VI Transparent? Vero 

Pulsante OK Center Falso

Pulsante Stop Stop Falso
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Proprietà
Utilizzate le seguenti proprietà e metodi sulla classe VI:

• ShowMenuBar—Quando questa proprietà è true, la barra menu del VI 
è visibile.

Figura 5-4.  Barra menu del VI

• TitleBarVisible—Quando questa proprietà è true, la barra title del VI è 
visibile.

Figura 5-5.  Barra Title del VI

• RunVITransparently—Quando questa proprietà è true, la trasparenza 
del VI può variare. Il valore di default di questa proprietà è false, così 
dovete scrivere un valore true su questa proprietà prima di variare la 
trasparenza del VI.

• Transparency—Questa proprietà varia la trasparenza del VI. La 
proprietà accetta qualsiasi valore tra 0 e 100. Un valore pari a 0 rende il 
VI completamente opaco (comportamento normale) e un valore pari a 
100 rende il VI completamente trasparente (invisibile). Per questo 
esercizio, impostate il valore su 50 quando viene cliccato il pulsante 
Make VI Transparent?.

Metodi
Diversamente dalle proprietà, un metodo ha un effetto ogni volta che lo 
chiamate. Perciò, dovreste chiamare i metodi solo quando volete effettuare 
un’azione. Per esempio, se chiamate il metodo Fp.Center durante ogni 
iterazione di un ciclo, il VI viene continuamente centrato, impedendo così 
all’utente di spostarlo. Potete usare una struttura Case per controllare la 
chiamata del metodo in una certa iterazione del ciclo. Utilizzate il seguente 
metodo sulla classe VI:

• Center—Ogni volta che viene chiamato questo metodo, il VI si sposta 
al centro dello schermo.

Suggerimento Utilizzate la finestra Context Help per vedere le descrizioni di ogni 
proprietà e metodo.Es
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Struttura del VI
Il VI interroga i controlli del pannello frontale ogni 50 ms ed imposta il 
valore delle proprietà sulla base del valore attuale dei controlli. Una struttura 
Case controlla l’esecuzione del metodo Center.

Implementazione
1. Aprite il VI Customize VI Window nella directory <Exercises>\

LabVIEW Core 2\Customize VI Window. Il pannello frontale di 
questo VI è mostrato in Figura 5-6.

Figura 5-6.  Pannello frontale del VI Customize VI Window 

Completate i seguenti passi per creare il diagramma a blocchi mostrato in 
Figura 5-7.

Figura 5-7.  Diagramma a blocchi del VI Customize VI Window 

Figura 5-8.  Caso False per il metodo Center

2. Inserite un While Loop intorno ai terminali.
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3. Create un riferimento al VI.

❑ Aggiungete un VI Server Reference al diagramma a blocchi alla 
sinistra del While Loop.

❑ Impostate il VI Server Reference su This VI se non lo è già.

Nota Utilizzando il riferimento This VI potete accedere a tutti i metodi e proprietà del 
VI attuale senza dover aprire e chiudere esplicitamente un riferimento.

4. Create un Property Node con la proprietà RunTransparently.

❑ Cliccate con il tasto destro sul riferimento This VI e selezionate 
Create»Property for VI Class»Front Panel Window»Run VI 
Transparently dal menu rapido per creare un Property Node. 

❑ Spostate il Property Node alla destra del riferimento This VI, fuori 
dal While Loop.

❑ Cliccate con il tasto destro sul Property Node e selezionate Change 
All To Write dal menu rapido.

❑ Cliccate con il tasto destro del mouse sulla proprietà 
FP:RunTransparently e selezionate Create»Constant dal menu 
rapido.

❑ Cambiate il valore della costante in True.

5. Create un Property Node con le proprietà ShowMenuBar, TitleBarVis e 
Transparency.

❑ Cliccate con il tasto destro sul riferimento This VI e selezionate 
Create»Property for VI Class»Front Panel Window»Show 
Menu Bar dal menu rapido per creare un altro Property Node.

❑ Espandete il Property Node affinché mostri tre elementi.

❑ Cliccate sul secondo elemento nel Property Node e selezionate 
Front Panel Window»Title Bar Visible.

❑ Cliccate sul terzo elemento nel Property Node e selezionate Front 
Panel Window»Transparency.

❑ Cliccate con il tasto destro sul Property Node e selezionate Change 
All To Write dal menu rapido. 

❑ Inserite il Property Node dentro il While Loop.
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❑ Aggiungete una funzione Select all’interno del While Loop.

❑ Aggiungete due numeric constants con valori 0 e 50 alla sinistra 
della funzione Select. 

❑ Collegate la costante numerica 0 all’ingresso f della funzione Select. 

❑ Collegate la costante numerica 50 all’ingresso f della funzione 
Select.

❑ Collegate i controlli booleani alle proprietà corrette, come mostrato 
in Figura 5-7.

6. Create un Invoke Node con il metodo Center.

❑ Cliccate con il tasto destro sul riferimento This VI e selezionate 
Create»Method for VI Class»Front Panel»Center dal menu 
rapido per creare un Invoke Node.

7. Aggiungete una Case structure intorno all’Invoke Node FP.Center.

8. Aggiungete al ciclo un’attesa di 50 ms.

❑ Aggiungete una funzione Wait (ms) al While Loop. 

❑ Cliccate con il tasto destro del mouse sull’ingresso milliseconds to 
wait e selezionate Create»Constant dal menu rapido. 

❑ Inserite 50 nella costante.

9. Impostate il While Loop affinché si arresti quando l’utente clicca sul 
pulsante Stop o quando si verifica un errore.

❑ Aggiungete una funzione Unbundle By Name al While Loop.

❑ Inserite una funzione Or nel While Loop.

10. Collegate il diagramma come mostrato in Figura 5-7 e in Figura 5-8. 
Assicuratevi di sostituire il tunnel cluster di errore con uno shift register.

11. Visualizzate all’utente qualsiasi errore possa verficarsi.

❑ Aggiungete un Simple Error Handler VI alla destra del While 
Loop.

❑ Collegate il VI Simple Error Handler allo shift register di uscita del 
cluster di errore dal While Loop.

12. Salvate il VI.

Es
em

pi
o



Lezione 5 Controllo dell’interfaccia utente

© National Instruments Corporation 5-11 LabVIEW Core 2 Manuale degli Esercizi

Test
1. Passate al pannello frontale del VI.

2. Mandate in esecuzione il VI.

3. Provate ciascun pulsante e osservate i risultati.

Fine dell’esercizio 5-2
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Esercizio 5-3 Impostazione dei Plot Name

Obiettivo
Utilizzate i control reference per creare un subVI che modifica le proprietà 
dei graph o dei chart.

Scenario
Create un subVI che vi consenta di assegnare un elenco di plot name ad un 
chart o ad un graph. Il subVI dovrebbe ridimensionare la plot legend quanto 
basta per consentire la visualizzazione di tutte le tracce.

Progetto

Ingressi e uscite

Control Reference
Sia Waveform Chart che Waveform Graph sono oggetti della classe 
GraphChart. Per scrivere un subVI che possa accettare riferimenti sia ai 
chart che ai graph dovete utilizzare un control reference weakly typed della 
classe GraphChart. Tuttavia questa classe contiene anche altri chart e graph, 
come XY Graph. Questo VI genera un errore se l’utente collega un qualsiasi 
tipo di grafico diverso da Waveform Chart o da Waveform Graph. Potete 
determinare se l’utente ha collegato il tipo corretto utilizzando la proprietà 
ClassName per controllare una struttura Case. Se è stata collegata la classe 
corretta, utilizzate la funzione To More Specific Class per ottenere un 
riferimento alla sottoclasse appropriata. Dopo aver ottenuto un riferimento 
ad un WaveformChart o ad un WaveformGraph potete impostare le 
proprietà per modificare i plot name.

Tipo Nome Valore di default

Control Reference per un oggetto 
GraphChart

Graph 
Reference

N/A

1-D Array di Strings Control Plot Names Empty Array

Error Cluster Control Error In No Error

Error Cluster Indicator Error Out No Error
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Proprietà
Graph e chart non possiedono una singola proprietà per impostare tutti i plot 
name. Dovete utilizzare una combinazione di proprietà per impostare 
ciascun plot name. In questo esercizio, utilizzate le proprietà seguenti:

• ClassName—Questa proprietà restituisce una stringa che indica la 
classe del controllo dell’oggetto cui si riferisce la proprietà. Potete 
accedere a questa proprietà per ogni controllo. 

• LegAutosize—Questa proprietà controlla se Graph Legend si 
ridimensiona automaticamente per contenere tutti i plot name al suo 
interno. Prima di modificare i plot name dovreste impostare questa 
proprietà su False. Altrimenti la legenda potrebbe ridimensionarsi in 
modo tale da essere separata dal grafico o da coprire il grafico o altri 
controlli. 

• LegNumRows—Questa proprietà controlla il numero di righe visibili 
su Graph Legend. Quando aggiungete la vostra legenda al pannello 
frontale, ricordatevi di lasciare spazio alla legenda per consentirle di 
espandersi quando impostate questa proprietà. La legenda si espande 
verso il basso.

• ActPlot—Proprietà che agiscono su una traccia alla volta. Questa 
proprietà controlla la traccia attiva. Ogni volta che una proprietà della 
traccia viene impostata o letta essa si applica solo alla traccia attiva. Le 
tracce sono numerate in maniera sequenziale man mano che vengono 
create, a partire da zero. 

• Plot.Name—Questa proprietà imposta il nome della traccia attiva.

Implementazione
1. Aprite un VI vuoto.

2. Salvate il VI come Set Plot Names.vi nella directory 
<Exercises>\LabVIEW Core 2\Set Plot Names.

3. Create il pannello frontale.

❑ Aggiungete un control refnum al pannello frontale. 

❑ Chiamate il control refnum Graph Reference.

❑ Cliccate con il tasto destro su Graph Reference e scegliete Select 
VI Server Class»Generic»GObject»Control»GraphChart»
GraphChart dal menu rapido.

❑ Aggiungete un array al pannello frontale.
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❑ Chiamate l’array Plot Names.

❑ Aggiungete uno string control all’array vuoto Plot Names

❑ Aggiungete un cluster error in.

❑ Aggiungete un cluster error out.

❑ Disponete i controlli come mostrato in Figura 5-9.

Figura 5-9.  Pannello frontale di Set Plot Names

Suggerimento Siccome il pannello frontale di questo subVI non è visibile all’utente, non 
dovete sforzarvi molto per renderlo graficamente accattivante. Dovreste sempre 
organizzare i vostri pannelli frontali in maniera logica. Tuttavia, non dovete sprecare 
tempo su pannelli che l’utente non vede.

4. Passate al diagramma a blocchi.

5. Identificate la classe del control reference e generate un errore se la 
classe non è valida.

❑ Utilizzate il Class Browser per cercare e rilasciare il ClassName 
Property Node.

– Aprite il dialogo Class Browser selezionando View»Class 
Browser.

– Selezionate VI Server per l’Object Library.

– Selezionate Generic»Generic per Class.

– Cliccate sul pulsante Search per aprire il dialogo Class Browser 
Search.
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Figura 5-10.  Dialogo Class Browser Search

– Selezionate Generic class nella sezione Search Scope.

– Inserite Class Name nel campo di ricerca. Class Name 
dovrebbe essere l’unico elemento nei risultati di Search.

– Cliccate su OK per tornare alla finestra di dialogo Class 
Browser. Class Name è evidenziato nell’albero Properties and 
Methods. 
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Figura 5-11.  Finestr di dialogo Class Browser

– Cliccate sul pulsante Create e poi spostate il vostro mouse su 
un’area vuota del diagramma a blocchi. Cliccate sul diagramma 
a blocchi per rilasciare il Property Node ClassName.

– Chiudete la finestra di dialogo Class Browser.

❑ Collegate Graph Reference all’ingresso reference del Property 
Node.

Figura 5-12.  Caso DefaultEs
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❑ Aggiungete una Case structure al diagramma a blocchi, come 
mostrato in Figura 5-12.

❑ Collegate l’uscita ClassName del Property Node al case selector 
della struttura Case.

❑ Passate al caso False della struttura Case.

❑ Cancellate il testo False nel nome del caso così che il nome del 
caso somigli alla Figura 5-12.

Il caso Default della struttura Case viene selezionato se la classe del 
control reference non corrisponde ad uno degli altri casi. In questo 
caso, se va in esecuzione il caso di default, allora il control reference 
passato a questo subVI non è un WaveformGraph o un 
WaveformChart. Ricordate che in una struttura Case, l’etichetta del 
case selector riconosce le maiuscole.

❑ Aggiungete un Error Cluster From Error Code VI alla struttura 
Case.

❑ Cliccate con il tasto destro sull’ingresso error code del VI Error 
Cluster From Error Code e selezionate Create»Constant dal menu 
rapido. 

❑ Inserite 1057 nella costante.

Il codice di errore 1057 corrisponde al messaggio Object cannot 
be typecast to the specified type. Questo è l’errore 
appropriato da generare se il chiamante del subVI passa un control 
reference della classe sbagliata.

❑ Collegate il diagramma a blocchi come mostrato in Figura 5-12.
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6. Gestite i riferimenti del WaveformGraph.

Figura 5-13.  Caso WaveformGraph

❑ Passate al caso True della struttura Case.

❑ Cambiate il testo True nel nome del caso in WaveformGraph così 
che il nome del caso somigli alla Figura 5-13.

Attenzione Il testo inserito nell’etichetta del case selector deve corrispondere 
esattamente alla stringa d’ingresso, incluso spazi e maiuscole. Per questo esempio, 
inserite WaveformGraph.

❑ Aggiungete una funzione To More Specific Class alla struttura 
Case.

❑ Cliccate con il tasto destro sull’ingresso target class della funzione 
To More Specific Class e selezionate Create»Constant dal menu 
rapido.

❑ Cliccate sulla costante che avete creato nel passaggio precedente e 
selezionate la classe Generic»GObject»Control»GraphChart»
WaveformGraph»WaveformGraph.

❑ Utilizzate la finestra Class Browser per cercare e rilasciare Legend: 
Autosize Property Node all’interno della struttura Case.

– Object library: VI Server

– Classe: Generic»Generic 

– Selezionate All classes in the VI Server library nella sezione 
Search Scope.Es
em

pi
o



Lezione 5 Controllo dell’interfaccia utente

© National Instruments Corporation 5-19 LabVIEW Core 2 Manuale degli Esercizi

– Stringa di ricerca: Legend: Autosize

– Selezionate Legend: Autosize con tipo di classe 
WaveformGraph

❑ Collegate l’uscita specific class reference della funzione To More 
Specific Class all’ingresso reference del Property Node.

❑ Espandete il Property Node per visualizzare due proprietà.

❑ Cliccate sulla seconda proprietà nel Property Node e selezionate 
Legend»Number of Rows.

❑ Cliccate con il tasto destro sul Property Node e selezionate Change 
All To Write dal menu rapido.

❑ Cliccate con il tasto destro del mouse sulla proprietà LegAutosize e 
selezionate Create»Constant dal menu rapido. Verificate che il 
valore della costante sia False.

❑ Aggiungete una funzione Array Size alla struttura Case.

❑ Aggiungete un For Loop alla struttura Case.

7. Aggiungete un Property Node al For Loop.

❑ Utilizzate la finestra Class Browser per cercare e rilasciare Active 
Plot Property Node all’interno del For Loop.

– Object library: VI Server

– Classe: Generic»Generic 

– Selezionate All classes in the VI Server library nella sezione 
Search Scope.

– Stringa di ricerca: Active Plot

– Selezionate Active Plot con tipo di classe WaveformGraph

❑ Collegate l’uscita reference out del secondo Property Node 
attraverso il bordo del For Loop all’ingresso reference del terzo 
Property Node.

❑ Espandete il terzo Property Node per visualizzare due proprietà.

❑ Cliccate sulla seconda proprietà nel Property Node e selezionate 
Plot»Plot Name dall’elenco.
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❑ Cliccate con il tasto destro sul Property Node e selezionate Change 
All To Write dal menu rapido.

❑ Collegate il diagramma a blocchi come mostrato in Figura 5-13. 
Utilizzate degli shift register quando connettete i collegamenti error 
attraverso il For Loop. Verificate che l’auto-index sia abilitato sul 
tunnel Plot Names del For Loop.

8. Gestite i riferimenti del WaveformChart.

Figura 5-14.  Caso WaveformChart

❑ Cliccate con il tasto destro sul bordo della struttura Case e 
selezionate Duplicate Case dal menu rapido.

❑ Inserite WaveformChart nel nome del caso.

Attenzione Il testo inserito nell’etichetta del case selector deve corrispondere 
esattamente alla stringa d’ingresso, incluso spazi e maiuscole. Per questo esempio, 
inserite WaveformChart.

❑ Cliccate sulla costante di riferimento del WaveformGraph e 
selezionate Generic»GObject»Control»GraphChart»
WaveformChart.

Nota Quando cambiate la classe di un control reference, tutti i Property Node e Invoke 
Node che utilizzano il riferimento diventano non validi poiché le proprietà si riferiscono 
ad una classe che non corrisponde al riferimento. Notate che tutti i nomi delle proprietà 
cambiano in nero quando cambiate il riferimento alla classe e che la freccia run è 
spezzata. Lasciate i collegamenti spezzati, poiché i collegamenti si riconnettono quando 
riselezionate le proprietà.Es
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❑ Cliccate su ciascuna delle quattro proprietà e selezionate 
nuovamente la proprietà corretta. Le quattro proprietà sono 
Legend»Autosize, Legend»Number of Rows, Active Plot e Plot»
Plot Name. Il diagramma a blocchi risultante appare come mostrato 
nella Figura 5-14.

9. Create l’icona e il connector pane per il subVI. La Figura 5-15 mostra 
un esempio di icona e connector pane.

 

Figura 5-15.  Connessioni del connector pane per il VI Set Plot Names

❑ Passate al pannello frontale del VI.

❑ Cliccate con il tasto destro sul connector pane e selezionate 
Patterns dal menu rapido per scegliere uno schema. 

❑ Collegate il connector pane.

❑ Cliccate con il tasto destro sull’icona e selezionate Edit Icon dal 
menu rapido.

❑ Utilizzate gli strumenti nell’Icon Editor per creare un’icona. 

❑ Chiudete l’Icon Editor quando avete finito.

10. Salvate il VI.

Connessioni Connector pane
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Test
1. Testate il VI utilizzando un Waveform Graph.

 

Figura 5-16.  Test di Set Plot Names

❑ Create un VI vuoto.

❑ Aggiungete un Waveform Graph al pannello frontale.

❑ Aprite il diagramma a blocchi.

❑ Cliccate con il tasto destro sull’indicatore Waveform Graph e 
selezionate Create»Reference dal menu rapido.

❑ Aggiungete il Set Plot Names VI al diagramma a blocchi del nuovo 
VI.

Suggerimento  Se il VI Set Plot Names è aperto, potete trascinare l’icona dall’angolo 
superiore destro del suo pannello frontale sul diagramma a blocchi del nuovo VI.

❑ Collegate il riferimento del WaveformGraph all’ingresso Graph 
Reference del VI Set Plot Names.

❑ Cliccate con il tasto destro del mouse sull’ingresso Plot Names del 
VI Set Plot Names e selezionate Create»Control dal menu rapido. 
Il diagramma a blocchi dovrebbe assomigliare alla Figura 5-16.

❑ Passate al pannello frontale del nuovo VI.

❑ Inserite One e Two come elementi nell’array Plot Names.

❑ Spostate Plot Legend alla destra del grafico così da poter espandere 
la legenda.

❑ Mandate in esecuzione il VI. One e Two compaiono nella legenda.
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2. Testate il VI utilizzando un Waveform Chart.

❑ Cliccate con il tasto destro sul waveform graph e selezionate 
Replace»Graph»Waveform Chart dal menu rapido.

❑ Inserite Three come altro elemento nell’array Plot Names.

❑ Mandate in esecuzione il VI. Three compare nella legenda del 
diagramma.

3. Testate il VI con un XY Graph.

❑ Cliccate con il tasto destro sul waveform chart e selezionate 
Replace»Graph»XY Graph dal menu rapido.

❑ Aggiungete Four come altro elemento nell’array Plot Names.

❑ Mandate in esecuzione il VI. Si verifica un errore di definizione di 
tipo.

Nota L’errore è visualizzato perché il control reference dell’XY Graph non è supportato 
nel subVI. 

4. Chiudete il VI. Non avete bisogno di salvare il VI utilizzato per testare 
il VI Set Plot Names.

Fine dell’esercizio 5-3
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Nota
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